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eBay

There are more than 25 million registered eBay
users, and 75% of them use the U.S. Postal
Service as their shipping method. Learn how to
buy, sell and ship on eBay; print mailing labels and
postage; and request package pickup, featuring a Click-N-Ship
demonstration by Jeanee Mooney.

Jeanee Mooney is a Customer Relations Coordinator at the Utica Post
Office. She’s been at this office since November 2007 and previously spent
three years in the same position in Missoula, MT.  

Jeanee has been with the postal service for over thirteen years. Her
efforts have always been focused on providing the best customer service
possible to the postal customer, regardless of her position within the
organization. The best help comes in consumer knowledge and that’s where
the eBay classes come in.

As Jeanee has presented the classes, she’s
found that often the perspective EBay seller
just needs the confidence and encouragement
to get started.

Come join us in learning more about eBay. ˜

Q & A SIG
Due to a prior commitment, Bill
will not be able to conduct the
October Q&A meeting. The
November meeting will be held
on Thursday, Nov. 6 at 6:30PM
in Room 522 at Whitesboro HS.



Stay connected . . . to the MVPCUG

Mohawk Valley PC User Group, Inc.

$25 for initial sign-up  - $20 for renewal

  Name___________________________________________________

  Address_________________________________________________

  City__________________________________________________NY

  Zip___________________Phone_____________________________

  E-mail___________________________________________________

Please mail this application with a check payable to MVPCUG to

M V P C U G

PO Box 586

Marcy NY 13403-0586
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The MVPCUG EXPLORER is published monthly from

September through June by the Mohawk Valley Personal Computer

User Group, Inc.(MVPCUG), PO Box 586, Marcy NY 13403-0586.

Opinions expressed herein are the writers and are not reflective of

the MVPCUG, nor are they considered substantiated by inclusion in

this newsletter. All articles are copyrighted by their respective authors

but may be reprinted by other User Groups provided credit is given

to the author and this publication.

The. MVPCUG was founded in 1981 by individuals interested in

IBM compatible computers. This non-profit organization consists of

volunteers whose expertise range from novice to professional.

Regular meetings are held on the first Tuesday of the month at

6pm, usually at the Whitesboro High School, Route 291, Marcy NY.

A typical agenda consists of discussion of business affairs and a

demonstration of computer related products.  Meetings are open to

the public.

Initial membership fee for an individual is $25. Annual renewal
dues are $20.

OFFICERS and DIRECTORS

President

Jerry Finkelstein . . . . . . . . . . . . . . . . . . . . . 797-5296

. . . . . . . . . . . . . . . . . demetrius28 at roadrunner.com

Vice President

Lisa Britt . . . . . . . . . . . . . . . . . ydaith at hotmail.com

Treasurer

Bill Gorrell . . . . . . . . . . . . . . . . . . . . . . . . . 853-3256

. . . . . . . . . . . . . . . . . . . . lwgorrell at roadrunner.com

Secretary

open . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Directors-at-Large

Helen Russell [‘08] . . . . . . . . . . hrcnb at capital.net

Jim Pease [’09] . . . . . . jamesrpease at yahoo.com

Lou Barile [‘10] . . . . . . . . . . . . . l.barile at verizon.net

Our internet presence is at

h t t p : / / w w w . m v p c u g . c o m
Web Master

Lisa Britt . . . . . . . . . . . . . . mvpcug@usadatanet.net

NEWSLETTER STAFF

Patricia Bruno . . . . . . . . . . pbruno315 at gmail.com

Jerry Finkelstein . . . demetrius28 at roadrunner.com

Donna Gorrell . . . . . . . . dgorrell at roadrunner.com

John Hunter . . . . . . . . . . . . jhunter1 at twcny.rr.com

Bob Schaffer . . . . . . . rdschaffer at roadrunner.com

Editorial notes . . .
  In November we elect a new

President of the United States. In
December we elect officers of the

MVPCUG. Nominations are generally
made in November or earlier; now is

the time to think of those members that you would like
to see as the governing body of the MVPCUG.

Who’s Job Is It?
  This is a story about four people named Everybody,

Somebody, Anybody and Nobody.
   There was an important job to be done and Everybody

was sure Somebody would do it. Anybody could have
done it, but Nobody did it. Somebody got angry about

that because it was Everybody's job. Everybody thought
anybody could do it, but Nobody realized that Everybody

wouldn't do it. It all ended up that everybody blamed
Somebody when Nobody did what Anybody could have

done.

Meeting Agenda

5:30 . . . . . . . . . . . . . . Meet and Greet
6:00 . . . . . . . . . . . . Business Meeting
6:30 . . . . . . . . . . . . . . Program, Part 1
7:10 . . . . . . . . . . . . . . . . . . . . . . Break
7:20 . . . . . . . . . . . . . . Program, Part 2
8:00 . . . . . . . . . . . Drawing for Prizes
8:15 . . . . . . . . . . . . . . . . Adjournment

mailto:mvpcug@usadatanet.net
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The MVPCUG general meeting was held at the Whitesboro

HS cafeteria. President Jerry Finkelstein called the meeting to

order at 6:10 PM. There were 17 persons in attendance.

BUSINESS MEETING

President Jerry Finkelstein called the meeting to
order. He greeted members and visitors and hoped
that everyone had a great summer. Jerry also
reminded everyone that a club secretary is still
needed to record the minutes of the meetings till the
end of Dec. 2008.

A treasury report was given by Bill Gorrell for the
period of June l to Aug. 31, 2008. The club received
$122.46 in revenues and spent $557.13 leaving a net
expense for the month at $434.67. Account balances
as of Aug.31 includes $96.17 in the checking account
and $2,795,54 in the money market for a total
$2,891.71.

Bill advised the members that he made a sizeable
savings in getting the club’s liability insurance
lowered, with a savings of over $200. Bill also
advised the members that due to a prior commitment
the Q&A SIG for Oct 2nd is canceled. The Q&A will
resume on Nov 6th.

Patty Bruno, Program chair, advised Jerry and
members that the program for October will be a
presentation on eBay. In November the presentation
will be on Internet Security. Patty also requested that
if any of the members have any presentations that
they would like to have at future meetings to contact
Patty at: pbruno315@gmail.com.

PROGRAM

The annual September program consisted of “Ask the
Guru” with any questions concerning problems or
advice on computers. Our two Guru experts, Lisa
Britt and Bill Gorrell did a splendid job in answering
the many questions from the members. Throughly an
enjoyable and enlightening session for the members.

DOOR PRIZES
[furnished with club funds]

1GB Flash Drive . . . . . . . . . . . . . . . Jerry Finkelstein
10 pk CD cases . . . . . . . . . . . . . . . . . . Helen Russell
15 DVD-R w/Cases . . . . . . . . . . . . . . . . . . Jim Pease
HP Photo Paper . . . . . . . . . . . . . . . . . . . . . Fred Cole

[Donated by Smart Computing]

One year Subscription . . . . . . . . . . . . . Jim Schmandt

[Donated by QUE Books]

M/S office 2007, live lessons . . . . . . . . . . Bill Wilson
M/S Windows Vista . . . . . . . . . . . . . George Pupura

The meeting adjourned at 8:05 PM.

Helen Russell, acting secretary ˜

  Minutes of September 2, 2008
— H. Russell, Acting Secretary  

HELP HOTLINES

Corel Draw
 Patricia Bruno . . . . . . . . . . . . pbruno315@gmail.com

Hardware
  Bill Gorrell . . . . . . . . . . . lwgorrell@roadrunner.com

WordPerfect/Graphic editing
  Donna Gorrell . . . . . . . . donna.gorrell@yahoo.com 

If you need help with any of the above feel free to email

the names listed. If you can offer help in any programs

that you might be familiar with, please send your name

and email address to donna.gorrell@yahoo.com so we

might include you in our Help Hotlines.

Our club motto—“Members Helping Members”

mailto:pbruno315@gmail.com
mailto:pbruno315@gmail.com
mailto:lwgorrell@roadrunner.com
mailto:donna.gorrell@yahoo.com
mailto:donna.gorrell@yahoo.com
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Using the Ribbon
You can think of the Ribbon of tools and

commands in the 2007 Microsoft Office system as
your visual gallery to create professional and visually
interesting documents. In the 2007 Office, there are
no dialog boxes for formatting text and images. The
formatting tools that you are used to using still exist,
but they are integrated into the Ribbon. You can use
the new tabs to move across various sets of
commands or Ribbons that make up the Microsoft
Office Fluent user interface. Additionally, while you
are working on a document, the Ribbon automatically
presents you with the right formatting tools at the
right time and place. It reveals a visual gallery to help
you quickly and easily format documents. For
example, if you want to change the positioning of a
picture you have imported into a Word document:
Double-click the image. A Picture Tools tab opens a
gallery that displays options to choose from. Select
the Position option from the gallery on the Picture
Tools tab to easily define where the photo will sit
within the text.

Apply Formatting from Any 2007 Office Release
Document to Any Other

You may already know that you can use
Document Themes to apply consistent fonts, colors,
and graphic effects all at once throughout your 2007
Microsoft Office release Word, Excel, or PowerPoint
document. But did you know that you can apply the
theme formatting from any 2007 Word, Excel, or
PowerPoint file to any other? To do this, on the Page
Layout tab (in Word or Excel) or the Design tab (in
PowerPoint), click to expand the Themes gallery, and
then click Browse for Themes. You can then choose
any 2007 Word, Excel, or PowerPoint file (or any
theme file) and apply its theme formatting to your
active document.

OUTLOOK 2007
Share Your Calendar via E-Mail 

If you want to share your calendar with
colleagues, here’s how:  Open your calendar; click
Send a Calendar via E-mail. Select the period that
you want to share [such as today, tomorrow, or the
next 7 days]. You now have an e-mail message ready
to send with your selective calendar details attached.

Enter the e-mail addresses of those you want to
receive it, and then send the message.

WORD 2007
Find Tooltips for Keyboard Shortcuts

If you press and hold the ALT key, tooltips appear
above the commands at the top of the page. You can
then press the appropriate letter for a simple keyboard
shortcut.

Research Unfamiliar Words and Phrases in Word
Open the Research pane: To access the Research

pane quickly, press ALT and click the word that you
want to check; To research a phrase, select the phrase,
press ALT, and click the selection. Customize your
research options. At the bottom of the Research pane,
click Research options, and then choose which
services you want to use. For instance, you might
want to switch to the U.K. English dictionary.

EXCEL 2007 
Change Your Default Chart Type 

To quickly create a chart on its own sheet in an
Excel workbook, select the chart data, then press the
F11 key. This action generates a chart using your
default chart type, which is originally set to be a
clustered column chart. To change your default chart
type, on the Insert tab, at the bottom-right corner of
the Charts section, click the dialog box launch icon to
open the Insert Chart dialog box. Select your preferred
chart type, then click Set as Default Chart. You can
then click Cancel to close the dialog box without
generating a chart. Though nothing appears to have
changed, the next time you generate a chart by using
the F11 key, you’ll automatically get your new default
chart type. Note: After you’ve created a chart, you can
still change the chart type. To change chart type for
just the active chart, on the Chart Tools Design tab, in
the Type section, click Change Chart Type.

POWERPOINT 2007
Apply WordArt Text Effects 

You can easily liven up your slide titles and text by
using WordArt and Text Effects. Highlight the text to
which you want to apply effects. On the Format tab,
locate the WordArt Quick Styles gallery. Select a
WordArt style if you want to apply a predefined style
to your text. Add custom effects like reflection, glow,
3-D rotation, and bevel by using the Text Effects
gallery. ˜
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H
arvest time is right on our doorstep. Have you
wondered where you should go to get that fall
pumpkin or apple cider?  Well, I will try to

head you in the right direction.

Have you ever been to Fly Creek? The Fly Creek
Cider Mill and Orchard just
outside Coopers town, NY is nice
day trip. At flycreekcidermill.com
you can look through the autumn
schedule of events ~ happening
throughout the fall. Check it out!!!

If you would like to educate yourself about APPLES,
then I suggest that you take a look at
www.nyapplecountry.com.
This site has everything
from recipes to finding
apple cider in the county
in which you live. You’ll
find my favorite ~
www.northstarorchards.com
as well as other links to festivals and nutrition and all
sorts of fun things. Check it out!!

The New York Farmers Market begins in May and
comes to a close in early November,
each location throughout the county has
their own set schedule.
www.nyfarmersmarket.com so . . .
Check it out!!

How about something different? 
Take a trip to Rhinebeck, NY
for the  Sheep and Wool
Festival ~October 18 & 19 ,
2008. www.sheepandwool.com
The website is great, and you
may even hear them say they
are from Upstate, NY! Check it out!!!

Ú Apples, Pumpkins And Pears
Canning Class
3 hour courses ~NH  BOCES  
Check out www.moboces.org
Don’t wait! Classes start soon!

Some GREAT sites that are available
to all of us are at
www.agmkt.state.ny.us. Just
remember, a link can lead you almost
anywhere. Check out the New York by
Rail brochure, travel throughout New York State and
check out the festivities !!!

Beginning at the Willet Center, a two
evening candlelit tour of Fort Stanwix,
learn of actual events at the fort that
made life terrifying, day and night.
Mysterious tales that will keep you on
guard throughout the night.
Mysteries, Myths and Mayhem
October 18   & 25  and it’s FREE!th th

http://tinyurl.com/6z3rkk. Check it out !!!

Did you know that October is “National Popcorn
Poppin Month”? This site has recipes
for popcorn and fun facts and activities
for children www.popcorn.org  
Check it out!!!

Wolf Oak Acres is the place you wanna be ~ If you
have never been to a CORN MAZE you have to
check out ~ www.wolfoakacres.com .
Located in Oneida, NY. 
The Stittville Fire Department has a
CORN MAZE as well. Check out ~
http://maze04.tripod.com  
Sept 27  through Oct 25    th th

Open  weekends!

Back to Class!
BOCES Adult Education is in its fall schedule of
classes. They have plenty of computer classes to
choose from ~ located at  www.moboces.org
If you are interested, sign up soon.

• Microsoft Word-Level -I, II
• Computer Keyboarding
• Computer Upgrade and Maintenance
• Beginner classes offered from  Sept-Jan
• PC Entertainment

Classes are offered in Utica, New Hartford, Rome
and Verona. Some classes start right away, others
start throughout the fall. Check it out!!! �

  What's Happening!!!
— by Patricia Bruno  

http://www.flycreekcidermill.com
http://www.nyapplecountry.com
http://www.northstarochards.com
http://Www.nyfarmersmarket.com
http://www.sheepandwool.com
http://www.moboces.org
http://www.agmkt.state.ny.us
http://tinyurl.com/6z3rkk
http://www.popcorn.org
http://www.wolfoakacres.com
http://maze04.tripod.com
http://www.moboces.org
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For the Person With Everything

F
or those of you who are addicted to kitchen
gadgets, the following web site may tickle your
culinary fancy. WWW.firebox.com has many

useful gifts for the kitchen maniac. Want to practice
your quick draw with a culinary pistol? Try the
condiment gun, a plastic weapon that dispenses
mustard, or ketchup at offending burgers or dogs.
Price is just $29.95 and will be back in stock about
the time you read this.

Or, if you want to flout your Zorro moves, how
about a BBQ sword? Just load up your sword with
franks or steaks and thrust away. The weapon even
ships with a genuine cardboard Lone Ranger mask to
hide your culinary identify. Costs only $29.95 and
offers the user a wooden handle for the stainless steel
two-pronged fork. Silly but handy.

Price is No Object Department
Some collectors scour the earth trying to find

objects that no one else has. For any of you who
suffer from this malady, click on gottahaveit.com.
This site professes to “Curate Our Culture” by putting
up for bid, those items that some people just have to
acquire regardless of price. Like what, you ask? How
about a signed photograph of Jack Nicklaus with an
asking price of $650? Or a game worn pair of NY
Nicks road basketball shorts that belonged to Rolando
Blackman with a bid minimum of $550? No one
would buy this stuff you say. Oh really. Some one
recently paid $11,616 for Madonna’s handwritten
daily planner/diary. Honest. Oh to be rich!

Bargains for Students
Back in the day, I spent hundreds of dollars each

semester buying textbooks. College students still lay
out mucho dinero for
textbooks. If your student is
short on cash, why not suggest
the  following sites that offer
textbook bargains in one form
or another for poor scholars.
WWW.coursesmart.com may
have just the text your student
needs.  Six of the largest
textbook publishers sell subscriptions to digital copies

of their books via this site. According to the home-
page savings averaged $57.45 per eTextbook
purchased in September.

Other sources of cheaper textbooks include
www.booksprice.com and www.Bigwords.com. For
example, Bigwords promises to “protect the universe
from high textbook prices.” The site will sell or buy
regular textbooks as well as trade books. Featured the
day of my visit was Bob Woodward’s recently
published The War Within: A secret Whitehouse
History 2006–2008 with a list price of $32. Prices on
the site range from $22.69 shipping included from
half.com to $24.37 at Amazon.com. The site provides
an “Uber-Marketplace” which “shows you every offer
from every store.” This may be too late for the current
semester, but try in January for the next semester.

Cheap Printer Ink
Printer manufacturers find that ink or toner is more

profitable than the printer it is used in. Thus many
companies encourage users to purchase new
cartridges before the old ones are empty. Some
companies such as Brother place a sensor in the
cartridge that warns when toner is low. To use all the
ink in a Brother cartridge, place a piece of black tape
on the chip and fool the evil little thing. Other
companies use different methods to get you to buy
more ink, but typing your printer’s model number in
Google followed by the words “override or cheap”
will get you the necessary workaround. At 
fixyourownprinter.com/ the site provides the info you
need to fix your printer cartridge so that you can get
more pages from it before you have to buy a new one.

More Browser Wars
Last month I warned Google about Cuil, the

newest browser in town. This month Microsoft gets
the warning. Google has just released a Beta version
of its new browser that promises a head to head fight
with Microsoft Internet Explorer. Chrome is the
newest challenger for your web browsing. Click on
www.google.com/chrome for a complete description
of this new tool. The best feature seems to be that you
can use web apps without opening your browser.
According to Google, you will get your web search,
web history and address bar all in one box. And it’s
free. Be careful, Microsoft, I think I hear footsteps
coming up hard behind you.

Until next time . . . ˜

   Sites to Visit on the ‘Net
— by John Hunter    

http://WWW.firebox.com
http://www.gottahaveit.com
http://WWW.coursesmart.com
http://www.booksprice.com
http://www.Bigwords.com
http://www.half.com
http://www.Amazon.com
http://www.fixyourownprinter.com/
http://www.google.com/chrome
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. . . that there is a program that will copy text and
allow you to paste selected entries? Clipomatic,
available at mlin.net/Clipomatic.shtml allows you to
copy multiple items of text using CTRL-C. When you
want to paste, put your cursor where you want to add
the text, use CTRL-ALT-V key combination to bring
up a list of copied items. From the pop-up menu, use
the mouse to click on the selection you want.

. . . that there is a screen capture program which
allows you to capture a whole page or only parts of a
Web page? Download it at: faststone.org [FastStone
Capture 6.2]. After selecting an area, a window pops
up showing the selection. You can print directly,
without pasting into any other program. It works for
text, pictures, and tables. You can also add text to the
cropped site, arrows pointing to a specific location.

. . . that you can clean up your hard disk to recover
some space if you need more room? Microsoft saves
a backup folder whenever you install an update. This
allows you to uninstall updates. Most of us don’t
bother to uninstall; we let these folders accumulate.
Update backup folders are located in your Windows
directory [look for the Windows folder on the C:
drive]. Make sure WindowsXP shows Hidden Files.
[To do so from an Explorer window, choose Tools
and then Folder Options, click the View tab, then
make sure Show Hidden Files And Folders option in
the Advanced Settings is selected.] You should be
able to see folders which begin with the prefix $NT
[on my system they are listed in blue]. You can safely
delete older folders, but keep the most recent
updates–those installed within the past few months.
Also, do NOT delete a folder named $nf_mig$ as this
folder prevents future updates from overwriting
certain system files with outdated versions.

. . . that another way to save space is to reduce your
Recycle Bin? By default, 10% of your hard disk is
devoted to the Recycle Bin. You can change this by
right-clicking the Recycle Bin, selecting Properties
and adjusting the slider bar to lower the percentage of
reserved space. If you have multiple drives, you can
use different settings on each drive. Select Configure
Drives Independently radio button and then make the
adjustment using the individual tab for each drive. ˜

If you've been trying to keep up with the national
election campaigns you’ve been influenced by
bloggers across the Net. Mainstream media mention
them a lot, get information
from them even as they
fact-check them and label
their opinions as
masquerading as facts.
Mainstream media have
even brought a few bloggers
to task for making up whole stories and passing them
off as truth. True, all campaigns tend to stretch the
truth, but these days the bloggers are ever ready to
aggressively promote the misleading ads and throw
themselves in with the smarmy sarcasm and general
nastiness.

Of course, not all bloggers are
nasty. Some try to be objective
in their explanations of life as
it is lived and do try to respect
the intelligence of the reader.
Not all information is
misstatement. Still, blogs do
come with reputations,
political perspectives, personal
bias. Surfing the blogs, you travel at your own risk.

Using your PC for informational purposes, the blog is
a useful resource. I’m looking forward to learning a
lot about eBay at our next general meeting.  eBay is

another informational
resource, one that can earn
you lots of money. It was
interesting to note that Gov.
Palin of Alaska, in her efforts
to cut her budget, put her state
plane on eBay. She mentioned
this in her speeches but it was

through a blog that I found out it didn’t sell. Who
knew the PC could get so political?

Just beyond the brochure for the church lunch, right
after you look up the movie schedule at your local
theater, the PC can easily get you in the very thick of
controversial thought and a heated, even nasty,
political debate. ˜

  Did You Know . . .
— Donna Gorrell   

 Byting Remarks
— Jerry Finkelstein   

http://www.mlin.net/Clipomatic.shtml
http://www.faststone.org


eBay
Tuesday ‚ October 7, 2008 ‚ 6:00 PM ‚ Whitesboro High School

               what’s.com/ing October 2008             

Sunday Monday Tuesday Wednesday Thursday Friday Saturday

US Navy established Oct 13, 1775

United Nations Day Oct 24

1 2 3 4

    5 6 7      Monthly

General Meeting

6:00 PM

Whitesboro HS

8 9 10 11

    12 13  Columbus Day 14

Board of

Directors Meeting

6:30 PM

15 16 17 18

    19 20 21 22 23 24 25

 

    26 27 28 29 30 31
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